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1 Introduction

This introduction describes the concepts of exposing AutoCAD® objects through a managed .NET
application programming interface (API). The AutoCAD .NET API allows you to automate tasks such
as creating and modifying objects stored in the database of a drawing file or change the contents of a
customization file. This guide covers using Microsoft® Visual Studio® 2008, and the programming
languages Microsoft® Visual Basic® .NET (referred to in this guide as VB.NET) and Microsoft® Visual
C#® with the AutoCAD .NET API.

Topics in this section

Guide Organization

Overview of the AutoCAD .NET API
Components of the AutoCAD .NET API
Overview of Microsoft Visual Studio
For More Information

Sample Code
Transition from ActiveX Automation to .NET

Guide Organization

This guide provides information on how to use the AutoCAD .NET API with Microsoft Visual Studio
and the programming languages VB.NET and C#. Information specific to developing applications
using Microsoft Visual Studio can be found under the topics “Getting Started with Microsoft Visual
Studio” and “Develop Applications with Microsoft Visual Studio.”

Programmers developing with the .NET Framework using a development environment other than
Microsoft Visual Studio can skip these two chapters. However, all of the example code in this guide is
presented in VB.NET and C#.

Overview of the AutoCAD .NET API

The AutoCAD .NET API enables you to manipulate AutoCAD and drawing files programmatically with
the assemblies or libraries that are exposed. With these objects exposed, they can be accessed by
many different programming languages and environments.

There are several advantages to implementing a .NET API for AutoCAD:

Programmatic access to AutoCAD drawings is opened up to more programming
environments. Before the .NET API, developers were limited to ActiveX® Automation and
languages that supported COM, AutoLISP®, and C++ with ObjectARX.

Integrating with other Windows® based applications, such as Microsoft Excel and Word, is
made dramatically easier by using an application’s native .NET API or exposed ActiveX/COM
library.

The .NET Framework is designed for both 32-bit and 64-bit operating systems. Visual Basic
for Applications was only designed for 32-bit operating systems.



Allows access to advanced programming interfaces with a lower learning curve than those for
more traditional programming languages such as C++.

Objects are the main building blocks of the AutoCAD .NET API. Each exposed object represents a
precise part of AutoCAD, and they are grouped into different assemblies and hamespaces. There are
many different types of objects in the AutoCAD .NET API. For example:

Graphical objects such as lines, arcs, text, and dimensions
Style settings such as text and dimension styles
Organizational structures such as layers, groups, and blocks
The drawing displays such as view and viewport

The drawing and AutoCAD application

For information on some of the files which make up the AutoCAD .NET API, see Components of the
AutoCAD .NET API.

Components of the AutoCAD .NET API

The AutoCAD .NET API is made up of different DLL files that contain a wide range of classes,
structures, methods, and events that provide access to objects in a drawing file or the AutoCAD
application. Each DLL file defines different namespaces which are used to organize the components
of the libraries based on functionality.

The three main DLL files of the AutoCAD .NET API that you will frequently use are:

AcDbMgd.dll. Use when working with objects in a drawing file.
AcMgd.dll. Use when working with the AutoCAD application.
AcCui.dll. Use when working with customization files.

Use an AutoCAD .NET API DLL

Before classes, structures, methods, and events found in one of the AutoCAD .NET API related DLLs
can be used, you must reference the DLL to a project. After a DLL is referenced to a project, you can
utilize the namespaces and the components in the DLL file in your project.

Once a AutoCAD .NET API DLL is referenced, you must set the Copy Local property of the
referenced DLL to False. The Copy Local property determines if Microsoft Visual Studio creates a
copy of the referenced DLL file and places it in the same directory as the assembly file of the project
when it is built. Since the referenced files already ship with AutoCAD, creating copies of referenced
DLL files can cause unexpected results when you load your assembly file in AutoCAD.

Location of AutoCAD .NET API DLL files
The AutoCAD .NET API DLL files can be located at <drive>:\Program Files\AutoCAD 2010 or as part

of the AutoCAD 2010 ObjectARX SDK which can be downloaded from http://www.objectarx.com or
the Autodesk Developer Network Web site (http://www.autodesk.com/adn).

After the ObjectARX SDK is installed, the DLL files can be found in the inc-win32 and inc-x64 folders
under the main install folder.

NoteThe DLLs in the ObjectARX SDK are simplified versions of the same files that ship with
AutoCAD, as they do not contain dependencies on the AutoCAD user interface. It is recommended



that you download and install the ObjectARX SDK, and then reference the DLL files that come with
the SDK instead of those that are found in the install directory of AutoCAD 2010.

Procedures

= To download and install the AutoCAD 2010 ObjectARX SDK

Launch your default Internet browser application and browse to http://www.objectarx.com.
On the Web page, click License & Download.

Fill in the required fields and select ObjectARX for AutoCAD 2010. Click Submit.

On the Download page, click Download Now to use the Download Manager or click Standard
Download Method to use the default download method of your Internet browser.

Click Save or the option used to save the file to your local drive.

Specify a location to download the ObjectARX SDK package file.

Once the package file is downloaded, browse to the location you saved it to and double-click
it.

PwbNPE

No o

The install wizard is displayed.

8. Inthe ObjectARX <Release> dialog box, specify a new install location or leave the default
install location. Click Install.

The install wizard closes after it is finished if no problems were encountered.

= To install the ObjectARX Wizard and the Managed project templates

1. Once the ObjectARX SDK is installed, browse to its install folder which is by default
c:\ObjectARX <Release>.

After browsing to the install folder, open the Utils folder and then the ObjARXWiz folder.

In the ObjARXWiz folder, double-click ArxWizards.msi.

In the ObjectARX Wizards for AutoCAD 2010 dialog box, click Next.

In the Enter Your Preferred Default RDS Symbol box, enter an abbreviation of your company’s
name and click Next.

arwd

The text you enter for the RDS is used as a prefix to the names of the default class or
commands created with the ObjectARX Wizard and project templates.

NoteRDS stands for Registered Developer Symbol, and is used to create ungiuely named
commands and classes to help avoid potential conflicts with other applications.

6. On the Member Variable Wizard page, leave Replace MS Member Variable Wizard by
Autodesk Member Variable Wizard selected and click Next.

7. On the Select Installation Folder page, click Browse to specify a new installation location for
the wizard or leave the default location. Click Next.

8. Click Next again to install the wizard.

9. Click Close to close the installer.

=l To reference an AutoCAD .NET API DLL

1. In Microsoft Visual Studio, click View menu 3 Solution Explorer to display the Solution
Explorer if it is not already displayed.

In the Solution Explorer, on the toolbar along the top, click Show All Files.

Right-click the References node and click Add Reference.

In the Add Reference dialog box, Browse tab, select the DLL file that contains the library you
want to use and click OK.

5. In the Solution Explorer, click the plus sign to the left the References node to expand it.

Pown



6. Select the referenced library from the References node.
7. Right-click over the selected reference and click Properties.
8. Inthe Properties window, click the Copy Local field and select False from the drop-down list.

Overview of Microsoft Visual Studio

Microsoft Visual Studio is an object-oriented programming environment that runs independently of
AutoCAD. While Microsoft Visual Studio is external to AutoCAD and other applications, it is able to
interact with applications that expose either a native .NET API or ActiveX/COM library.

Topics in this section

Which Edition of Microsoft Visual Studio to Use
Use COM Interoperability with .NET
Dependencies and Restrictions

Which Edition of Microsoft Visual Studio to Use

Microsoft Visual Studio is available in multiple versions and editions. To use the .NET API for
AutoCAD 2010, you need to use:

Microsoft Visual Studio 2008 with Service Pack 1
Microsoft .NET Framework 3.5 with Service Pack 1

If you are using AutoCAD 2007 through AutoCAD 2009, you should use:

Microsoft Visual Studio 2005
Microsoft .NET Framework 2.0 or later

Microsoft Visual Studio is offered in two editions: for free and for pay. The free edition is known as
Microsoft Visual Studio 2008 Express Edition, while the for pay editions vary by nhame and price due
to the different development tools that are incorporated into them. Microsoft Visual Studio 2008
Standard Edition is the entry level edition which provides improved debugging over Microsoft Visual
Studio 2008 Express Edition along with a number of other features. The most common edition of
Microsoft Visual Studio used by developers is Microsoft Visual Studio 2008 Professional Edition.

NoteWhile it is possible to use Microsoft Visual Studio Express with the AutoCAD .NET API, this
guide assumes you are using one of the other versions such as Microsoft Visual Studio 2008
Standard Edition or Microsoft Visual Studio 2008 Professional Edition.

There are four main advantages to using Microsoft Visual Studio:

Robust and accessible development environment that has a modest learning curve.

VBA and VB.NET syntax are similar, which makes it an ideal environment for existing VBA
users.

Visually intuitive and extensive dialog box creation tools.



Projects can be built as a standalone executable or DLL assembly which can then be loaded
into AutoCAD for execution.

NoteUnlike VBA projects, .NET applications do not suffer from performance degradation when loaded
and run in 64-bit AutoCAD.

For more information on the different editions of Microsoft Visual Studio, see
http://www.microsoft.com/vstudio and http://www.microsoft.com/express.

Use COM Interoperability with .NET

Microsoft Visual Studio can utilize both native .NET and COM interfaces in the same project. By
utilizing COM interop, you can migrate existing code that might have been written in Visual Basic 6 or
VBA without having to completely rewrite it. To access AutoCAD automation objects from a project
created in Microsoft Visual Studio, create references to the following files:

The AutoCAD 2010 type library, acax18enu.tlb, located at <drive>:\Program Files\Common
Files\Autodesk Shared.

The AutoCAD/ObjectDBX Common 18.0 type library, axdb18enu.tlb, located at
<drive>:\Program Files\Common Files\Autodesk Shared.

NoteThe previous mentioned type libraries are also available as part of the ObjectARX SDK. For
information on downloading and installing the ObjectARX SDK, see Components of the AutoCAD
NET API.

These references will make the following primary interop assemblies available:

Autodesk.AutoCAD.Interop.dll (for AutoCAD-specific types)
Autodesk.AutoCAD.Interop.Common.dll (for types shared by ObjectDBX™ host applications)

The interop assemblies are located in the global assembly cache; they map automation objects to
their .NET counterparts.

After you reference the type libraries, you can declare AutoCAD-based variables in Microsoft Visual
Studio, as in the following examples:

VB.NET

Dim objAcApp As Autodesk.AutoCAD.Interop.AcadApplication
Dim objLine As Autodesk.AutoCAD.Interop.Common.AcadLine

C#

Autodesk.AutoCAD.Interop.AcadApplication objAcApp;
Autodesk.AutoCAD.Interop.Common.AcadLine objLine;

Utilizing the interop assemblies can make the transitioning your VBA projects over to VB.NET much
easier. However, in order to take full advantage of everything that .NET and the AutoCAD .NET API
have to offer, you will need to rewrite your existing VBA code.

Create and Reference the AutoCAD Application



AutoCAD 2010 .NET applications can utilize the same type library (acax18enu.tlb) as AutoCAD
automation projects. The type library is located in <drive>:\Program Files\Common Files\Autodesk
Shared.

AutoCAD 2010 .NET applications also use the same version-dependent ProgID for the CreateObiject,
GetObject, and GetinterfaceObject functions. For example, CreateObject ("AutoCAD.Application.18")
allows you to create an instance of AutoCAD and get an object that represents the new instance of
the application.

Dependencies and Restrictions

Unlike ActiveX Automation, there are fewer issues with library conflicts when other applications are
installed, reinstalled, or uninstalled. The reason for fewer compatibility issues is that the .NET
Framework is a standardized platform. However, you can still run into dependency issues. To avoid
dependency issues with the .NET Framework, be sure to use the same or an earlier version of the
.NET Framework with your VB.NET or C# project that AutoCAD 2010 uses. For information on which
version of the .NET Framework you should be referencing, see Which Edition of Microsoft Visual
Studio to Use.

For More Information

This guide assumes that you have working knowledge of either the VB.NET or C# programming
languages, and does not attempt to duplicate or replace the abundance of documentation available
on either of these programming languages. If you need more information on VB.NET or C#, and using
Microsoft Visual Studio, see the Help system for Microsoft Visual Studio developed by Microsoft,
available from the Help menu in Microsoft Visual Studio.

Sample Code

This guide and the AutoCAD 2010 ObjectARX SDK together contain a large number of sample
projects, subroutines, and functions that demonstrate the use of the classes, structures, methods,
properties, and events that make up the AutoCAD .NET API.

You can also find sample projects that demonstrate some of the aspects of the AutoCAD .NET API
on the Autodesk website at http://www.autodesk.com/developautocad. These sample projects show a
wide range of fuctionality, from extracting AutoCAD drawing data into Microsoft Excel spreadsheets to
drawing and performing stress analysis on an electrical transmission tower.

Many of these samples show how to combine various aspects of the VB.NET and C# programming
languages with the power of the AutoCAD .NET API to create custom applications.



Additionally, sample code in the AutoCAD .NET Developer's Guide can be copied from the Help files,
pasted directly into an open code editor window in Microsoft Visual Studio, and then built and loaded
in AutoCAD. At the top of most code samples in this guide are the namespaces that are required for
that particular sample. Add those that are need to top of the code window.

NoteThe sample code in the Help files contains limited error handling to keep the concepts simple
and easy to read. You should apply additional error handling and checking when using any sample
code in your project. For more information on error handling, see Handle Errors.

Procedures

=" To run the sample code from the Help files

1. In Microsoft Visual Studio, open a code editor window, add the proper namespaces and define
a class if one does not already exist.

Copy the sample code from the Help file and paste the copied code into the defined class.

In Microsoft Visual Studio, click Build menu = Build <Project>.

In AutoCAD, at the command prompt, enter netload and press Enter.

In the Choose .NET Assembly dialog box, select the built assembly file. Click Open.

At the command prompt, enter the name of the command or AutoLISP function and any
required parameters defined in the loaded assembly.
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Transition from ActiveX Automation to .NET

AutoCAD 2010 continues to support VBA, but the VBA components must be enabled by downloading
and installing them from http://www.autodesk.com/vba-download.

While there is no established release in which VBA will no longer be supported in AutoCAD, we
recommend that you begin migrating your existing VBA projects to ensure that you are ready when
VBA support is dropped. We recommend that you develop any new applications with Microsoft Visual
Studio and the AutoCAD .NET API, AutoLISP, or C++ and ObjectARX.

You can continue to use the AutoCAD COM Automation library in .NET to help make your transition
from VBA to VB.NET easier, see Use COM Interoperability with .NET. If you are new to .NET, see
Getting Started with Microsoft Visual Studio for basic information on working with Microsoft Visual
Studio and the AutoCAD .NET API.

2 Getting Started with Microsoft Visual Studio

This chapter introduces you to the AutoCAD® .NET API and some of the basics of the Microsoft®
Visual Studio® development environment. Along with an introduction to the development environment,
you will also learn about the NETLOAD command in AutoCAD and some of the terminology used
throughout this guide.

Topics in this section



Understand Microsoft Visual Studio Projects

Define the Components in a Project

View Project Information

Work with Microsoft Visual Studio Projects

Edit an Existing Project or Solution

Load an Assembly into AutoCAD

Access and Search Referenced Libraries (Object Browser)
Exercises: Create Your First Project

Related AutoCAD Commands and Terminology

More Information

Understand Microsoft Visual Studio Projects

Project files created with Microsoft Visual Studio are not specific to AutoCAD, but do contain
specific project settings that you will need to be familiar with in order to create a DLL
assembly file that can be loaded into AutoCAD. This guide discusses creating projects for
Visual Basic® (VB) .NET and Visual C#® with and without the ObjectARX Wizard for
AutoCAD 2010.

A project is a collection of code and resource files; class modules, WPF windows, and
Windows forms that work together to perform a given function. When a project is created, a
solution is also created which contains the project you are creating. A solution is used to
reference one or more projects. Usually you do not have to work with a solution directly
unless you want to reference the exposed functionality of other projects.

An example of a multi-project solution is when you have a new project and an existing project
that contain a set of methods, functions, and classes that you want to use with a new project.

A solution can contain any combination of VB.NET and C# projects. Using different types of
projects in a single solution allows each developer to use the programming language of his or
her choice.
Project and solution files have the following file extensions:

VBPROJ - Microsoft Visual Basic (VB) .NET project file

CSPROJ - Microsoft Visual C# project file
SLN - Microsoft Visual Studio solution file

Define the Components in a Project

Each project can contain many different components. The different components of a project
can contain class modules, forms, references, and resources.



Class Modules

Components that contain public and private procedures and functions. Class modules are
used to define custom namespaces. Within a namespace, you define the procedures used
for your program and define the structures to implment custom commands and AutoLISP
functions.

Forms

Form components contain custom dialog boxes you lay out for use with your project. Forms
in your project are displayed using a procedure or function, unless you build a stand-alone
application. Windows forms, WPF windows, and user controls are some of the form types
that can be part of a project. For this guide, forms can mean either Windows forms and WPF
windows.

References

References are used to indicate which projects or libraries your project uses.

View Project Information

The Solution Explorer, which displays the current solution and a list of all loaded projects,
also displays the code, class, and form module files contained in each loaded project, and
the references to the external libraries used by each project.

The Solution Explorer has its own toolbar, which can be used to open various project
components for editing. Use the View Code button to open the code for a selected module in
the Editor Window. Use the View Designer button to display the Visual Designer for a
selected form or the View Class Diagram to work with classes.
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The Solution Explorer is visible by default. If it is not visible, click View menu = Solution
Explorer or press Ctrl+Alt+L.

Work with Microsoft Visual Studio Projects

An open solution or project file can be viewed and accessed from the Solution Explorer. The Solution
Explorer allows you to add new items and projects to the current solution and projects, unload a
project from the current solution, change the properties of an opened solution or project, and add
references to a project in the current solution, among many choices. All available tasks for working
with the current solution or project can be accessed via the right-click menu of the Solution Explorer.
For information on the Solution Explorer, see View Project Information.

NoteBefore creating a new project, make sure Service Pack 1 for Microsoft Visual Studio 2008 is
installed.

Procedures
= To start Microsoft Visual Studio

On the Start menu, click (All) Programs = Microsoft Visual Studio 2008 3 Microsoft Visual
Studio 2008.



Topics in this section

Create a New Project

Open an Existing Project or Solution
Save a Project or Solution

Work with Multiple Projects in a Solution

Create a New Project

New projects are created based on a project template. When creating a new project that will
be built into a DLL assembly that will be loaded into AutoCAD, use the Class Library template
that comes with Microsoft Visual Studio or one of the AutoCAD Managed project application
templates that get installed with the ObjectARX Wizard for AutoCAD 2010. Both types of
templates are available for the VB.NET and C# programming languages.

After a new project is created, you will need to reference the files that make up the AutoCAD
.NET API. For information on referencing the files associated with the AutoCAD .NET API
and installing the ObjectARX Wizard for AutoCAD 2010, see Components of the AutoCAD
.NET API.

Procedures
= To create a new project using a standard template

1. In Microsoft Visual Studio, click File menu *New » Project.

2. In the New Project dialog box, Project Types tree, expand Other Languages = Visual
Basic or Visual C# and click Windows.

3. Under Templates, select Class Library.
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4. In the Name box, enter a name for the new project.

5. In the Location box, enter a location or click Browse to select a folder for the new
project.

6. In the Solution Name box, enter a name for the new solution that the project will be
added to.

7. Optionally, select the Create Directory for Solution check box to create a sub-folder
before creating the new solution and project. Select the Add to Source Control check
box to add the solution and project to a source control database.

8. Click OK.

=/ To create a new project using an AutoCAD Managed template
Before using one of the AutoCAD Managed templates, you must first download and install

the AutoCAD 2010 ObjectARX SDK. For information on installing the AutoCAD Managed
project templates, see Components of the AutoCAD .NET API.

1. In Microsoft Visual Studio, click File menu » New * Project.

2. In the New Project dialog box, Project Types tree, expand Other Languages and click
Visual Basic or Visual C#.

3. Under Templates, select AutoCAD Managed VB Project Application or AutoCAD
Managed C# Project Application.
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4. In the Name box, enter a name for the new project.

5. In the Location box, enter a location or click Browse to select a folder for the new
project.

6. In the Solution Name box, enter a name for the new solution that the project will be
added to.

7. Optionally, select Create Directory for Solution to create a sub-folder before creating
the new solution and project. Select Add to Source Control to add the solution and
project to a source control database.

8. Click OK.

9. In the AutoCAD Managed <language> Application Wizard - <project name> dialog

box, go to the Your Registered Developer Symbol box, and enter a string up to four
characters long.

The symbol entered is used as a prefix for the default class and command that is
added to the initial code module, and to avoid potential naming conflicts with other
referenced libraries.
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10.Optionally, if you will be working with libraries that utilize unmanaged code, select
Enable Unmanaged Debugging.

11.Optionally, select any of the additional .NET extensions you might need for your
project.

12.Click Finish.

Open an Existing Project or Solution

When you open a project or solution in Microsoft Visual Studio, the code editor and Windows
Form Designer windows are opened in the same state they were in when the project was last
saved. Once a project or solution is opened, use the Solution Explorer to navigate between
the files of the opened project or solution. For information on working with an open project or
solution see, Edit an Existing Project or Solution.

Procedures
= To open an existing project or solution file

1. In Microsoft Visual Studio, click File menu = Open = Project/Solution.
2. In the Open Project dialog box, browse to and select the project file to open.



The Open Project dialog box will allow you to open a wide range of project files which
include VB.NET and C# projects, Microsoft Visual Studio .NET solutions, Microsoft
Visual C++ projects and even legacy Microsoft Visual Basic 6 projects. Use the
Objects of Type drop-down list to control which type of projects or solutions you see in
the file selection area of the Open Project dialog box.

NoteYou cannot open a VBA project saved as a DVB file with Microsoft Visual Studio.
If you are migrating from VBA to VB.NET or C#, you can copy your code from the
AutoCAD VBA development environment to an open code editor window in Microsoft
Visual Studio and make the necessary changes.

3. Click Open.

Save a Project or Solution

Microsoft Visual Studio is a contextual based development environment, meaning that the
current item selected determines the available features in the development environment.
Controlling which changed files you save or how you want to save them is determined by the
Solution Explorer.

Once a project or solution is selected from the Solution Explorer, you can save it with its
current name, or perform a Save As on it to create a copy of the file. You can select one or
more items at a time in the Solution Explorer by pressing and holding the Ctrl key before
selecting an item. Most often, you will be saving all changed items at the same time.

Procedures
= To save a project or solution
1. In Microsoft Visual Studio, from the Solution Explorer, select the project or solution to
save.
2. Click File menu = Save <project or solution name> or Save <project or solution
name> As.

If you choose Save <project or solution name> As, the Save File As dialog box is
displayed.

3. If the Save File As dialog box is displayed, browse to a location to create a new copy
of the project or solution and enter a new name. Click Save.

= To save all changed items

In Microsoft Visual Studio, click File menu = Save All.



Work with Multiple Projects in a Solution

A solution can contain multiple projects. Working with multiple projects is not much different
than working with a single project. Use the Solution Explorer to navigate between the
projects in the current solution.

Add a project to a solution

You might add a project to a solution to copy code between projects. You might want to
reference the procedures, functions and classes in one project and use them in another
project. By adding multiple projects to a single solution, it allows you to use a project as a set
of common utilities that you might use with more than one project.

Unload a project from a solution

Projects can be unloaded from a solution when they are no longer needed. If you no longer
want a project to load with a solution, you can unload the project and then reference the
compiled DLL assembly of the project instead. Working with the compiled DLL helps to
prevent accidental edits to the source code.

Procedures
= To add a project to a solution

In Microsoft Visual Studio, do one of the following:

o Click File menu = Add = New Project to create a new project and add it to the
current solution. For information on creating a new project, see Create a New
Project.

o Click File menu = Add = Existing Project to display the Add Existing Project
dialog box and add an existing project to the current solution. In the Add
Existing Project dialog box, browse to and select the project to add to the
current solution.

=/ To unload a project from a solution

In Microsoft Visual Studio, Solution Explorer, right-click the project you want to unload
from the current solution and click Unload Project.

Edit an Existing Project or Solution

Once you have opened a project or solution into Microsoft Visual Studio, you can edit the projects,
class modules, forms, and references using the common development environment. You can also
debug and run projects from the common development environment.

Topics in this section

Add New Items
Import Existing Items




Edit Iltems

Rename a Project

Add and Reference Other Projects

Set the Options for Microsoft Visual Studio

Add New ltems

New items such as class modules and Windows forms can be added to a project. You are
responsible for updating the properties of an item (such as name) and for filling in the
appropriate code. When naming new items, remember that other developers may want to
use your items in future applications. Be sure to follow your company’s established naming
conventions or the standards established by Microsoft.

Procedures
= To add a new item to your project

1. In Microsoft Visual Studio, Solution Explorer, right-click the project to which you want
to add a new item and click Add » New Item.

Instead of clicking New Item, you can also click Windows Form, Module (VB.NET
only), or Class to add one of the main types of items to a project.

2. In the Add New Item - <Project> dialog box, select the template that represents the
item you want to add.
o Code File - Represents a code module
o Windows Form - Represents a form (or dialog box)
o Class - Represents a class module
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3. Enter a name for the new item and click Add.

Import Existing Iltems

Importing allows you to add an existing item to your project that might already exist in
another project. You can import code or class modules and forms. Files with the VB
extension can only be imported in a VB.NET project and CS files in a C# project. Class
diagrams are stored as CD files and can be imported in either project type.

When you import an item, a copy of the file or a link to the file you are importing is added to
the project. When a copy of the item is created, the original file is left unaltered in its original
place. Linked files provide access to the original file, which is great for reusing common code
that might be shared between multiple projects.

If you import an item with the same name as an existing item, you are prompted to replace
the existing item in the project with the one being imported.

The imported component is added to your project and appears in the Solution Explorer. To
edit the properties of the item, select the item in the Solution Explorer and change its
properties in the Properties window.

Procedures
= To import an existing item into a project




1. In Microsoft Visual Studio, Solution Explorer, right-click the project to which you want
to add an existing item and click Add » Existing Item.

2. In the Add Existing Item - <Project> dialog box, browse to and select the file that
contains the item you want to add.

3. Click Add to create a copy of the selected file, or click the down arrow to the right of
the Add button and click Add As Link to create a link to the file instead of creating a
copy of the file.

Edit Items
You edit code and class modules, and forms in the common development environment. Code and
class modules are edited in a Code window, while forms are edited in the Windows Form Designer.

You can open as many windows as you have items, allowing you to view the code in different forms
or modules, and copy and paste between them.

Procedures
= To edit an item in your project

In Microsoft Visual Studio, Solution Explorer, double-click the item you want to edit.

If you want to edit the code of aform or control on aform, while in the Windows Form
Designer, double-click the form or control to display the Code window for the form.

Topics in this section

Use the Code Window
Use the Windows Form Designer
Use the Properties Window

Use the Code Window

The Code window contains two drop-down lists, a split bar, and a margin indicator bar.

The two drop-down lists at the top of the Code window display the current object (class or
form) on the left and the procedures for the current object on the right. You can move around
your project by changing the object or procedure in these drop-down lists.

The splitter bar on the right side of the Code window allows you to split the window
horizontally. Simply drag the splitter bar down to create a second window pane. This feature
allows you to view two parts of your code simultaneously in the same code module. To close
the pane, drag the splitter bar back to its original location or double-click it.



The margin indicator bar is located vertically along the left side of the Code window. It is used
to display margin indicators that are used during code editing and debugging.
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Use the Windows Form Designer

The Windows Form Designer allows you to create custom dialog boxes for your project.

To add a control to a form, click the desired control from the Toolbox window to activate the
tool, and then click over the form in the Windows Form Designer to place and size the
control. You can align controls with a grid or other controls by setting the appropriate setting
form from the General category under the Windows Form Designer folder in the Options
dialog box. The General category allows you to control other grid related settings such as
size and layout mode.
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Each form that you design has the standard Maximize, Minimize, and Close buttons. These
buttons are implemented as part of the Windows Form item template. You change the
appearance and style of the dialog box by selecting the form object in the Windows Form
Designer and then using the Properties window.

To add code to the form or a control event, double-click the form or control once it is placed
on the form. This opens the Code window for form and adds the default event for the control.
Use the right-most drop-down list at the top of the Code window to select a different event
when you want to add it to the Code window for the form or control.

Procedures
= To enable snap and set the size for the grid

1. In Microsoft Visual Studio, click Tools menu = Options.
2. In the Options dialog box, expand the Windows Forms Designer folder node in the
Options tree and select General.
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3. In the Properties pane, click SnapToGrid and select True from the drop-down list.
4. Click GridSize and then click in the box to the right of GridSize. Enter a grid spacing
value using the format width,height.

5. Click OK.

Use the Properties Window

The Properties window is used to change the properties of files in the current project or
solution, as well as Windows forms and controls that are placed on a Windows form.
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Select the file or object (Windows form or control) that you want to modify. This displays its
properties in the Properties window. Select the property in the grid of the Properties window
that you want to change, and then enter or select a new value based on the selected

property.

Procedures
=/ To change a property

1.

In Microsoft Visual Studio, select a file or reference from the Solution Explorer, or an
object (a Windows form in the Windows Form Designer or a control on a Windows
form).

Display the Properties window if it is not already displayed.

To display the Properties Window, in Microsoft Visual Studio, do one of the following:

o Click View menu = Other Windows = Properties Window

o Press Alt+Enter

o Right-click the selected file, reference, or object and click Properties
On the Properties window, click the property you want to edit and then enter or select
a new value in the field to the right of the selected property name.

Rename a Project

When a project is created, the name of the project file is stored with the project. If the name
of a project file is changed outside of Visual Studio, the stored project name will not be
changed to match. As a best practice, only rename your project or solution from Visual



Studio to maintain consistency. For more information on creating a project, see Create a New
Project.

You can rename a project file from the Properties window or through Windows Explorer. The
project name is set when the project is first created, but can be renamed through the Solution
Explorer.

WarningWhile a project file can be renamed through Windows Explorer, it is not
recommended to do this. It can break the reference with the solution file or another project
file. If you break the reference with a solution or another project, when you open the solution
or project file, you will be notified that a reference is missing.

Procedures
= To change the name of a project

1. In Microsoft Visual Studio, Solution Explorer, right-click the project you want to rename
and click Rename.
2. In the In-place text editor, enter a new name.
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3. Press Enter or click outside the in-place text editor to finish renaming the project.

Add and Reference Other Projects

Adding and referencing projects allows you to share code across multiple projects. You can
create centralized libraries of commonly used methods, functions and classes, and then
reference the library when needed. Projects can be referenced in the following ways:

Add the project to a solution and reference it to a project within the solution
Reference a compiled assembly file to a project

When you add a project to a solution, a new node for the project is displayed in the Solution
Explorer. This node is titled the same as the project that was referenced. After a project is
added, it must be referenced to the project using the Add Reference dialog box.

If the project has been compiled into an assembly DLL file, you can reference the file to a
project using the Add Reference dialog box. After a project or assembly DLL file is



referenced to a project, you use the Imports or using declaration with the namespace or
project name to utilize any of the exposed objects (classes or forms) in your project.

Procedures
= To reference another project

1. Add a New Project or Existing Project to the current solution.

2. Once the project has been added to the current solution, in the Solution Explorer,
right-click the project that you want to add the project reference to and click Add
Reference.

3. In the Add Reference dialog box, Projects tab, select the project you want to
reference. Click OK.
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The selected project will appear under the References folder in the Solution Explorer.

4. Inthe Solution Explorer, double-click the code module that you want to use the
publicly exposed functions, methods, or objects that are in the referenced project.

5. At the top of the code module, add an Imports or using declaration for the project or
namespace in the project that contains the functions, methods, or objects you want to
use.

For example, if a namespace containing an exposed class in the referenced project is
named AdskUtilities, you would add the following to the code module to indicate that
you are going to use that namespace from the referenced project:

VB.NET

I mports AdskUtilities

C#



usi ng AdskUtilities;

6. Use the namespace in the same way you would any other .NET or COM library
referenced to your project.

Set the Options for Microsoft Visual Studio

You can change the characteristics of the common development environment by using the
Options dialog box.

The Options dialog box contains a variety of settings that affect the development
environment, code editor windows, Windows Form Designer, and debugging. Settings are
organized in folders that are available from the navigation pane on the left. Each folder
contains groups that are used to organize related options. Once a folder or group is selected,
the settings in that folder or group are displayed on the right side.

Some of the folders of settings you will work with are:

Environment. Settings used to control the display and behavior of elements within the
development environment.

Projects and Solutions. Settings used to create and build projects and solutions.

Text Editor. Settings used to control the behavior of text entered into a code window.
Debugging. Settings used to control the debugging environment.

Windows Forms Designer. Settings used to control the display and behavior of the
Windows Form Designer.

For more information on all available settings in the Options dialog box, select a folder from
the navigation pane in the Options dialog box and then click the *?’ button in the upper-right
corner. This displays the related topic in the Help file for Microsoft Visual Studio from
Microsoft.

Procedures
=l To display the Options dialog box

In Microsoft Visual Studio, click Tools menu » Options.

Load an Assembly into AutoCAD

Once a solution and project are created, a namespace and class are defined, and one or
more command or AutoLISP® function structures are implemented, you can use the
NETLOAD command to load a .NET assembly into AutoCAD.

Use the Debug Environment



Prior to loading a .NET assembly, you should determine if you need to use the Debug
environment of Microsoft Visual Studio to test any logic defined in the procedures and
functions you might have created. The Debug envioronment allows you to step through the
code in the .NET assembly as it is being executed in real-time. As the code is being
executed, you are able to check the values of variables and watch which logic paths of the
program are executed.

For more information on using the Debug environment, see the documentation that comes
with your development environment.

Procedures
= To load a .NET Assembly through Debug Mode in AutoCAD

1.

2.
3. On the Debug tab, under Start Action, click Start External Program and then click the

N o

In Microsoft Visual Studio, Solution Explorer, right-click the project you want to load
into AutoCAD. Click Properties.
In the <Project> Properties tab, click the Debug tab.

ellipsis button to the right of the text box.

In the Select File dialog box, browse to C:\Program Files\AutoCAD 2010 and select
acad.exe. Click Open.

With the project selected in the Solution Explorer, click Debug menu > Start
Debugging.

In AutoCAD, at the Command prompt, enter netload and press Enter.

In the Choose .NET Assembly dialog box, browse to the debug version of the
assembly file. Click Open.

TipThe location of the built assembly file is in the Output pane in Microsoft Visual
Studio.

At the Command prompt, enter the name of the command or AutoLISP function and
any required parameters.

= To load a .NET assembly in AutoCAD with NETLOAD

1.

In Microsoft Visual Studio, with a solution or project open, click Build menu = Build
Solution or Build <Project name>.

2. In AutoCAD, at the Command prompt, enter netload and press Enter.
3.

In the Choose .NET Assembly dialog box, browse to the built assembly file. Click
Open.

TipThe location of the built assembly file is in the Output pane in Microsoft Visual
Studio.

At the Command prompt, enter the name of the command or AutoLISP function and
any required parameters.

Access and Search Referenced Libraries (Object Browser)



The Object Browser is used to view the objects of a library referenced by the projects in a
current solution. From the Object Browser, you can navigate through a referenced library like
you would a directory structure. You can also use the Search menu and locate an object
based on an entered keyword.

Search Menu

Browse Menu
lass1.vb |~ MyFirstProject | Start Hage | Object Browser - X
Browse: My Salution v .| = 5| E -
<Searchs - Lj g Mewl)
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i ‘g Adshlame — 1| 3" Mew(System, IntPtr, Boolean) Members
'"{} Autodesk, AuboCAD. Colors W8 cniter fis Autodesk, AutoCAD, Geometry. Point3d Pane
---{} Autodesk, AukoCAD, CompaonentModel ﬁ] Endanglel) &s Double
E-{} Autodesk, AukoCAD, DatabaseServices 50 Length() As Double
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1% AttributeReference Autodesk. AutoCAD.Geometry. Point3d Descriotion
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—-2F AuditPass - Pane
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Objects Pane

The scope of the libraries you view in the Object Browser is limited by the Browse menu
drop-down list. You can limit the scope by the current solution, a specific release of the .NET
Framework or a custom component list.

The left side of the Object Browser contains a navigation pane which displays the available
libraries that you can navigate. The right side is divided into two halves: upper (Members
pane) and lower (Description pane).

Procedures
= To use the Object Browser

1. In Microsoft Visual Studio, click View menu = Object Browser (or press Ctrl+Alt+J).

The Object Browser should appear as a tab by default in the center of the
development environment.

2. Optionally, from the Browse menu, select a scope in which you want to navigate or
search for components.

3. Optionally, in the Search menu, enter or select a previous keyword that you want to
filter the Objects pane by.

4. In the Objects pane, navigate to the object you want to view and select it.

5. In the Members pane, select one of the displayed members of the selected object to
learn more about it.



Exercises: Create Your First Project

Now that you have learned the basics of using Microsoft Visual Studio, let's create a new project that
defines a new command. Once the new command is defined, you will learn to load the .NET
assembly into AutoCAD.

Topics in this section

Exercise: Create a New Project

Exercise: Reference the AutoCAD .NET API Files
Exercise: Create a New Command

Exercise: Set the Target Framework for a Project
Exercise: Build and Load a .NET Assembly in AutoCAD

Exercise: Create a New Project

In this exercise, you will create a new project named “MyFirstProject” and reference the files
of the AutoCAD .NET API.

To create a new project named “MyFirstProject”

1.

wn
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On the Start menu, click (All) Programs » Microsoft Visual Studio 2008 » Microsoft
Visual Studio 2008 to start Microsoft Visual Studio.

In Microsoft Visual Studio, click File menu = New > Project.

In the New Project dialog box, Project Types tree, expand Other Languages and click
Visual Basic or C#.

In the Templates list, select Class Library.

In the Name box, enter MyFirstProject.

In the Location box, click Browse to specify a new location or accept the default
location.

TipTo change the default location for new projects, display the Options dialog box and
select the Projects and Solutions folder from the navigation pane. Click the ellipsis
button to the right of the Visual Studio Projects Location and browse to a new default
location.

Click OK.



Exercise: Reference the AutoCAD .NET API Files

In this exercise, you will reference the .NET assemblies acmgd.dll and acdbmgd.dll. After you
reference the two files, you will adjust the properties of the referenced files so they are not
copied to the build directory.

For more information on referencing AutoCAD .NET API files, see Components of the
AutoCAD .NET API.

To reference the AutoCAD .NET API Files

1. In Microsoft Visual Studio, click View menu = Solution Explorer to display the Solution
Explorer if it is not already displayed.

2. In the Solution Explorer, on the toolbar along the top, click Show All Files.

3. Right-click the References node and click Add Reference.

4. Inthe Add Reference dialog box, Browse tab, browse to the install folder of AutoCAD
and select acmgd.dll. Press and hold Ctrl, and then select acdbmgd.dll. Click OK.

The default install location of AutoCAD is <drive>:\Program Files\AutoCAD 2010. If
you installed the ObjectARX SDK, you should reference the files from the inc-win32 or
inc-x64 folder.

5. In the Solution Explorer, click the plus sign to the left the References node to expand
it.

Press and hold Ctrl, and select AcDbMgd and AcMdg from the References node.
Right-click over one of the selected references and click Properties.

In the Properties window, click the Copy Local field and then select False from the
drop-down list.

© N o

NoteSetting Copy Local to False instructs Microsoft Visual Studio to not include the
referenced DLL in the build output for the project. If the referenced DLL is copied to
the build output folder, it can cause unexpected results when you load your assembly
file in AutoCAD.

Exercise: Create a New Command

Now that you have created a project and added the necessary library references, it is time to
create a command. The command will create a new multiline text (MText) object in Model
space. These and other concepts are discussed in-depth in later chapters.

To define a new command that creates a new MText object

1. In the Solution Explorer, double-click Classl.vb or Classl.cs based on the type of
project you created.

A code window is opened for the Class1 module and it should look like the following:



VB.NET

Public C ass C assl

End Cl ass

C#

usi ng System

usi ng System Col | ecti ons. Generi c;
usi ng System Li nq;

usi ng System Text;

nanespace MyFirstProjectl

{
public class O assl
{
}

}

Change the code in the code window to match the following:

VB.NET

| mports Autodesk. Aut oCAD. Runti me
| mports Autodesk. Aut oCAD. Appl i cati onServi ces
| nports Aut odesk. Aut oCAD. Dat abaseSer vi ces

Public Cass Cassl
<CommandMet hod( " AdskGreeti ng")> _
Public Sub AdskGeeting()
"' CGet the current docunent and database, and start a transaction
Di m acDoc As Document = Application. Docunent Manager. Mli Acti veDocunent
Di m acCur Db As Dat abase = acDoc. Dat abase

Usi ng acTrans As Transaction =
acCur Db. Transact i onManager. St art Transacti on()
"' Open the Block table record for read
Di m acBl kThl As Bl ockTabl e
acBl kThl = acTrans. Get Obj ect (acCur Db. Bl ockTabl el d,
OpenMbde. For Read)

"' Open the Block table record Mddel space for wite
Di m acBl kThl Rec As Bl ockTabl eRecord
acBl kThl Rec =
acTrans. Get Obj ect (acBl kThbl (Bl ockTabl eRecor d. Model Space), _
OpenMbde. ForWite)

"' Creates a new MIext object and assigns it a | ocation,
"' text value and text style
Di m obj Text As MIext = New Mrext

"' Set the default properties for the MIext object
obj Text . Set Dat abaseDef aul t s()

"' Specify the insertion point of the MIext object
obj Text . Locati on = New Aut odesk. Aut oCAD. Geonetry. Poi nt 3d(2, 2, 0)

"' Set the text string for the Mrext object
obj Text. Contents = "Greetings, Wlconme to the AutoCAD . NET
Devel oper's Cui de"

"' Set the text style for the Mrext object



End Sub
End Cl ass

C#

usi
usi
usi
usi

usi
usi
usi

ng
ng
ng
ng

ng
ng
ng

obj Text. Text Styl el d = acCur Db. Textstyl e
"' Appends the new Mrext object to npdel space
acBl kTbl Rec. AppendEnt it y(obj Text)

"' Appends to new MIext object to the active transaction
acTrans. AddNew yCr eat edDBObj ect (obj Text, True)

"' Saves the changes to the database and cl oses the transaction
acTrans. Conmit ()

End Usi ng

System

System Col | ecti ons. Generi c;
Syst em Li nq;

System Text ;

Aut odesk. Aut oCAD. Runt i ne;
Aut odesk. Aut oCAD. Appl i cat i onSer vi ces;
Aut odesk. Aut oCAD. Dat abaseSer vi ces;

[assenbly: ConmandC ass(typeof (MyFirstProjectl.Cassl))]

nanespace MyFirstProjectl

public class Cassl

{

[ CommandMet hod( " AdskGreeti ng")]
public void AdskG eeting()

{

!/l Get the current docunent and database, and start a transaction
Docurrent acDoc = Application. Docunent Manager . Mli Acti veDocunent ;
Dat abase acCur Db = acDoc. Dat abase;

/1 Starts a new transaction with the Transacti on Manager
using (Transaction acTrans =

acCur Db. Transact i onManager. St art Transacti on())

{
/1 Open the Block table record for read

Bl ockTabl e acBl kThbl ;
acBl kTbl = acTrans. Get Obj ect (acCur Db. Bl ockTabl el d,
OpenMbde. For Read) as Bl ockTabl e;

/1 Open the Block table record Mbdel space for wite
Bl ockTabl eRecord acBl kThl Rec;
acBl kThl Rec =

acTrans. Get Obj ect (acBl kThl [ Bl ockTabl eRecor d. Model Space],

OpenMbde. ForWite) as

Bl ockTabl eRecor d;

0);

/* Creates a new Mrext object and assigns it a |location,
text value and text style */
Mrext obj Text = new Mrext () ;

/1 Set the default properties for the Mrext object
obj Text . Set Dat abaseDef aul t s() ;

/1 Specify the insertion point of the Mlext object
obj Text . Locati on = new Aut odesk. Aut oCAD. Ceonet ry. Poi nt 3d(2, 2,



/1 Set the text string for the Mrext object
obj Text. Contents = "Greetings, Welcone to the Aut oCAD . NET
Devel oper's Quide";

/1 Set the text style for the Mrext object
obj Text. Text Styl el d = acCur Db. Text styl e;

/1 Appends the new Mrext object to nodel space
acBl kThl Rec. AppendEnt i ty(obj Text);

/1 Appends to new MIext object to the active transaction
acTrans. AddNew yCr eat edDBObj ect (obj Text, true);

/1 Saves the changes to the database and cl oses the
transaction

}

acTrans. Conmit();

Exercise: Set the Target Framework for a Project

In this exercise, you will specify the target framework that should be used when the project is
built.

To set the target framework for the “MyFirstProject”

1. In Microsoft Visual Studio, click View menu = Solution Explorer to display the Solution
Explorer if it is not already displayed.
In the Solution Explorer, on the toolbar along the top, click Show All Files.
Right-click the MyFirstProject project node and click Properties.
In the Project Designer, click the Applications tab.
Do one of the following:
o VB.NET - On the Compile tab, Advanced Compile Options, Target Framework
drop-down list, select .NET Framework 3.5.
o C# - On the Applications tab, Target Framework drop-down list, select .NET
Framework 3.5.

ablrwn

Exercise: Build and Load a .NET Assembly in AutoCAD

Now that you have a created a project and defined a command, you are almost ready to
execute the command in AutoCAD. Before you can execute the command in AutoCAD, you
need to first compile or build a .NET assembly file for your project.

For this exercise, you will be generating a Debug version of the project but you will not learn
about using the Debug environment at this time. For more information on debugging a



project, see the documentation that comes with your development environment. To load use
the Debug environment with AutoCAD, see Load an Assembly into AutoCAD.

If you want to distribute your project for others to use, you will need to build a .NET assembly
from your project. For more information on sharing your .NET assembly with others, see
Distribute Your Application.

Once a .NET assembly is built, you can then load it into AutoCAD with the NETLOAD
command.

To build a project and load a .NET assembly into AutoCAD

1.

In Microsoft Visual Studio, click Build menu = Build MyFirstProject.

The project should build successfully, unless something is wrong with the code in the
project. Look at the Output window for information on the build status of the project.
The location of the MyFirstProject.dll file that is built is also displayed in the Output
window.

Start AutoCAD if it is not already running.

In AutoCAD, at the Command prompt, enter netload and press Enter.

In the Choose .NET Assembly dialog box, browse to the location of the
MyFirstProject.dll that is displayed in the Output window in Microsoft Visual Studio and
select it. Click Open.

At the Command prompt, enter adskgreeting and press Enter.

A new MText object is created at the coordinates 2,2 with the text string “Greetings,
Welcome to the AutoCAD .NET Developer's Guide®.

Related AutoCAD Commands and Terminology

Commands
NETLOAD

Loads a .NET assembly into AutoCAD.

The Choose .NET Assembly dialog box, a standard file selection dialog box, is
displayed.

When FILEDIA is set to 0 (zero), NETLOAD displays the following command prompt:

Assembly file name: Enter a file name and press Enter.

Terminology
Assembly

A compiled project which has the DLL file extension.



VB.NET Project

A project file created with Microsoft Visual Studio that has the VBPROJ file extension.
C# Project

A project file created with Microsoft Visual Studio that has the CSPROJ file extension.
Code Editor Window

Window used to edit the code stored in a class module or form.
Solution

File used to manage one or more project files loaded into Microsoft Visual Studio.
Reference

A link to an API library file that is used by a project. A project file can also be
referenced to another project.

More Information

More information on the Microsoft Visual Studio development environment, and the VB.NET
or C# programming languages, is available from the Help files provided by Microsoft. To
access the Help files, choose one of the options from the Help menu in Microsoft Visual
Studio. You might also consider purchasing a book published by Microsoft® Press or a third-
party publisher.



3 Basics of the AutoCAD .NET API

To use the AutoCAD® .NET API effectively you should be familiar with the AutoCAD entities, objects,
and features related to the tasks you want to automate. The greater your knowledge of an object's
graphical and nongraphical properties, the easier it is for you to manipulate them through the
AutoCAD .NET API. For information specific to the members (methods, functions or properties) of an
object in the AutoCAD .NET API, see the AutoCAD .NET Reference Guide.

Topics in this section

Understand the AutoCAD Object Hierarchy
Access the Object Hierarchy

Collection Objects

Understand Properties and Methods
Out-of-Process versus In-Process

Define Commands and AutoLISP Functions

Understand the AutoCAD Object Hierarchy

An object is the main building block of the AutoCAD .NET API. Each exposed object represents a
precise part of AutoCAD. There are many different types of objects in the AutoCAD .NET API. Some
of the objects represented in the AutoCAD .NET API are:

Graphical objects such as lines, arcs, text, and dimensions
Style settings such as layers, linetypes, and dimension styles
Organizational structures such as layers, groups, and blocks
The drawing display such as view and viewport

Even the drawing and the AutoCAD application

The objects are structured in a hierarchical fashion, with the AutoCAD Application object at the root.
This hierarchical structure is often referred to as the Object Model. The following illustration shows
the basic relationships between the Application object and an entity that is in a BlockTableRecord,
such as Model space. There are many more objects in the AutoCAD .NET API that are not
represented here.
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Topics in this section

The Application Object

The Document Object

The Database Object

The Graphical and Nongraphical Objects

The Collection Objects

Non-Native Graphical and Nongraphical Objects

The Application Object

The Application object is the root object of the AutoCAD .NET API. From the Application
object, you can access the main window as well as any open drawing. Once you have a
drawing, you can then access the objects in the drawing. For information on working with
open drawing files (documents) see, The Document Object.

For example, the Application object has a DocumentManager property that returns the
DocumentCollection object. This object provides access to the the drawings that are currently
open in AutoCAD and allows you to create, save and open drawing files. Other properties of
the Application object provide access to the application-specific data such as InfoCenter, the
main window, and the status bar.The MainWindow property allows access to the application
name, size, location, and visibility.

While most of the properties of the Application object allow access to objects in the AutoCAD
NET API, there are some that reference objects in the AutoCAD ActiveX® Automation.



These properties include a COM version of the application object (AcadApplication), the
menubar (MenuBar), loaded menugroups (MenuGroups), and preferences (Preferences).

| Application )

Document
Manager

Document Window
Collection

———| InfoCenter )
——{  MainWindow )
—— MenuBar J
Menu Groups
— Preferences :|
e Fublisher

—( StatusBar )

Configuration

DocumentManager

Container for all the document objects (there is a
document object for each drawing that is open).

DocumentWindowCollection
Container for all the document window objects (there is
a document window object for each document object in
the DocumentManager).

InfoCenter
Contains a reference to the InfoCenter toolbar.

MainWindow

Contains a reference to the application window object
of AutoCAD.

MenuBar

Contains a reference to the MenuBar COM object for
the menubar in AutoCAD.

MenuGroups
Contains a reference to the MenuGroups COM object
which contains the customization group name for each
loaded CUIXx file.

Preferences
Contains a reference to the Preferences COM object
which allows you to modify many of the settings in the
Options dialog box.

Publisher

Contains a reference to the Publisher object which is
used for publishing drawings.

StatusBar

Contains a reference to the StatusBar object for the
application window.

UserConfiguration

Contains a reference to the UserConfiguration object



which allows you to work with user saved profiles.

The Document Object

The Document object, which is actually an AutoCAD drawing, is part of the
DocumentCollection object and provides access to the Database object which is associated
with the Document object. The Database object contains all of the graphical and most of the
nongraphical AutoCAD objects. For more information on the Database object, see The
Database Object.

Along with the Database object, the Document object provides access to the the drawing
status bar, the window the document is opened in, the Editor and Transaction Manager
objects. The Editor object provides access to functions used to obtain input from the user in
the form of a point or an entered string or numeric value. For more information on requesting
input from the user, see Prompt for User Input.

The Transaction Manager object is used to access multiple database objects under a single
operation known as a transaction. Transactions can be nested, and when you are done with
a transaction you can commit or abort the changes made. For more information on
transactions and the Transaction Manager object, see Use Transactions with the Transaction

Manager.
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The Database Object

The Database object contains all of the graphical and most of the nongraphical AutoCAD
objects. Some of the objects contained in the database are entities, symbol tables, and
named dictionaries. Entities in the database represent graphical objects within a drawing.
Lines, circles, arcs, text, hatch, and polylines are examples of entities. A user can see an
entity on the screen and can manipulate it.

You access the Database object for the current document by the Document object’s
Database member property.

Appl i cati on. Docunent Manager . Mli Act i veDocunent . Dat abase

Symbol Tables and Dictionaries

Symbol table and dictionary objects provide access to nongraphical objects (blocks, layers,
linetypes, layouts, and so forth). Each drawing contains a set of nine fixed symbol tables,
whereas the number of dictionaries in a drawing can vary based on the features and types of
applications used in AutoCAD. New symbol tables cannot be added to a database.



Examples of symbol tables are the layer table (LayerTable), which contains layer table
records, and the block table (BlockTable), which contains block table records. All graphical
entities (lines, circles, arcs, and so forth) are owned by a block table record. By default, every
drawing contains predefined block table records for Model and Paper space. Each Paper
space layout has its own block table record. For more information on working with symbol
tables, see Collection Objects.

A dictionary is a container object which can contain any AutoCAD object or an XRecord.
Dictionaries are stored either in the database under the named object dictionary or as an
extension dictionary of a table record or graphical entity. The named object dictionary is the
master table for all of the dictionaries associated with a database. Unlike symbol tables, new
dictionaries can be created and added to the named object dictionary. For more information
on working with dictionaries, see Collection Objects.

NoteDictionary objects cannot contain drawing entities.

= VBA/ActiveX Cross Reference

The Database object in the .NET API is similar to the Document object in the ActiveX
Automation library. To access most of the properties that are available in the Document
object of the ActiveX Automation library, you will need to work with the Document and
Database objects of the .NET API. For more information on the Document object of the .NET
API, see The Document Object.

The Graphical and Nongraphical Objects

Graphical objects, also known as entities, are the visible objects (lines, circles, raster images,
and so forth) that make up a drawing. Adding graphical objects to a drawing is done by
referencing the correct block table record, and then using the AppendEntity method with the
new object to append it to the drawing.

To modify or query objects, obtain a reference to the object from the appropriate block table
record, and then use the methods or properties of the object itself. Each graphical object has
methods that perform most of the same functionality as the AutoCAD editing commands such
as Copy, Erase, Move, Mirror, and so forth.

These objects also have methods to retrieve the extended data (xdata), highlight and
unhighlight, and set the properties from another entity. Most graphical objects have some
properties in common with each other such as Layerld, Linetypeld, Color, and Handle. Each
graphical object also has specific properties, such as Center, StartPoint, Radius, and
FitTolerance.

Nongraphical objects are the invisible (informational) objects that are part of a drawing, such
as Layers, Linetypes, Dimension styles, Table styles, and so forth. To create a new symbol
table records, use the Add method on the owner table or use the SetAt method to add a
dictionary to the named object dictionary. To modify or query these objects, use the methods
or properties of the object itself. Each nongraphical object has methods and properties
specific to its purpose; all have methods to retrieve extended data (xdata), and erase
themselves.
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The Collection Objects

AutoCAD groups most graphical and nongraphical objects into collections or container
objects. Although collections contain different types of data, they can be processed using
similar techniques. Each collection has a method for adding an object to or obtaining an item
from a collection. Most collections use the Add or SetAt methods to add an object to a
collection.

Most collections offer similar methods and properties to make them easy to use and learn.
The Count property returns a zero-based count of the objects in a collection, while the Item
function returns an object from a collection. Examples of collection members in the AutoCAD
.NET API are:

Layer table record in the Layers symbol table
Layout in the ACAD_LAYOUT dictionary
Document in the DocumentCollection
Attributes in a block reference



Non-Native Graphical and Nongraphical Objects

The AutoCAD .NET API is a cross implementation of ObjectARX and ActiveX Automation.
While you can access ActiveX Automation from ObjectARX, .NET API makes working with
the two rather seamless. As you work with objects using the native .NET API, you can
access the equivalent COM object from a property. In some cases, the COM object is the
only way to access an AutoCAD feature programmatically. Some examples of properties that
expose COM objects through the .NET API are, Preferences, Menubar, MenuGroups,
AcadObject and AcadApplication.

NoteWhen working with COM objects, you will want to make sure you reference the
AutoCAD 2010 type library. For information on COM Interop, see Use COM Interoperability
with .NET.

The Preferences property of the Application object provides access to a set of COM objects,
each corresponding to a tab in the Options dialog box. Together, these objects provide
access to all the registry-stored settings in the Options dialog box. You can also set and
modify options (and system variables that are not part of the Options dialog box) with the
SetSystemVariable and GetSystemVariable methods of the Application object. For more
information about using the Preferences object, see the ActiveX and VBA Developer’'s Guide.

Accessing COM objects is useful if you are working with existing code that might have been
originally developed for VB or VBA, or even when working with a third-party library that might
work with the AutoCAD ActiveX Automation library with the .NET API. Like the Preferences
object, you can also access utilities which translate coordinates or define a new point based
on an angle and distance using the Utility object which can be accessed from the
AcadApplication COM object which is the equivalent of the Application object in the .NET
API.

NoteWhen working with both the AutoCAD .NET API and ActiveX Automation, and you
create custom functions that might need to return an object, it is recommended to return an
Objectld instead of the object itself. For information on Object Ids, see Work with Objectids.




Access the Object Hierarchy

While the Application is the root object in the AutoCAD .NET API, you commonly will be working with
the database of the current drawing. The DocumentManager property of the Application object allows
you to access the current document with the MdiActiveDocument property. From the Document
object returned by the MdiActiveDocument property, you can access its database with the Database

property.

VB.NET
Appl i cati on. Docunent Manager . Mli Acti veDocunent . Dat abase. Cl ayer

C#
Appl i cati on. Docunent Manager . Mli Acti veDocunent . Dat abase. d ayer;

* VBA/ActiveX Code Reference
Topics in this section

Reference Objects in the Object Hierarchy
Access the Application Object

Reference Objects in the Object Hierarchy

When you work with objects in the .NET API, you can reference some objects directly or
through a user-defined variable based on the object you are working with. To reference an
objects directly, include the object in the calling hierarchy. For example, the following
statement attaches a drawing file to the database of the current drawing. Notice that the
hierarchy starts with the Application and then goes to the Database object. From the
Database object, the AttachXref method is called:

VB.NET

Dim strFNane As String, strBlkName As String
Di m obj I d As Aut odesk. Aut oCAD. Dat abaseSer vi ces. Gbj ect |l d

strFNane = "c:\clients\Proj 123\grid. dwg"
strBl kName = System | O Pat h. Get Fi | eNameW t hout Ext ensi on( st r FNane)

objld =
Appl i cati on. Docunent Manager . Mii Acti veDocunent . Dat abase. At t achXr ef (st r FNane,
st r Bl kNane)

C#

string strFName, strBl kNane;
Aut odesk. Aut oCAD. Dat abaseServi ces. Obj ectld objld;

strFNane = "c:/clients/Proj 123/grid.dwg";
strBl kName = System | O Pat h. Get Fi | eNaneW t hout Ext ensi on( st r FNane) ;



objld =
Appl i cati on. Docunent Manager . Mli Acti veDocunent . Dat abase. Att achXr ef (st r FNane,
st r Bl kNane) ;

To reference the objects through a user-defined variable, define the variable as the desired
type, then set the variable to the appropriate object. For example, the following code defines
a variable (acCurDb) of type Autodesk.AutoCAD.DatabaseServices.Database and sets the
variable equal to the current database:

VB.NET

Dim acCur Db As Aut odesk. Aut oCAD. Dat abaseSer vi ces. Dat abase
acCur Db = Application. Docunent Manager. Mli Acti veDocunent . Dat abase

C#

Aut odesk. Aut oCAD. Dat abaseSer vi ces. Dat abase acCur Db;
acCur Db = Application. Docunment Manager . Mli Acti veDocunent . Dat abase;

The following statement then attaches a drawing file to the database using the acCurDb
user-defined variable:

VB.NET

Dim strFNane As String, strBlkName As String
Di m obj I d As Aut odesk. Aut oCAD. Dat abaseSer vi ces. Gbj ect 1 d

strFNane = "c:\clients\Proj 123\ grid. dwg"
strBl kName = System | O Pat h. Get Fi | eNameW t hout Ext ensi on( st r FNane)

objld = acCurDb. Att achXref (strFNane, strBl kNane)

C#

string strFName, strBl kNane;
Aut odesk. Aut oCAD. Dat abaseServi ces. Obj ectld objld;

strFNane = "c:/clients/Proj 123/grid.dwg";
strBl kName = System | O Pat h. Get Fi | eNameW t hout Ext ensi on( st r FName) ;

objld = acCurDb. AttachXref (strFNane, strBl kNane);
Retrieve entities from Model space

The following example returns the first entity object in Model space. Similar code can do the
same for Paper space entities. Note that all graphical objects are defined as an Entity object:

VB.NET

| mports Autodesk. Aut oCAD. Runti e
| mports Autodesk. Aut oCAD. Appl i cati onServi ces
| nports Aut odesk. Aut oCAD. Dat abaseSer vi ces

<CommandMet hod( " Li stEntities")> _

Public Sub ListEntities()
"' CGet the current docunent and database, and start a transaction
Di m acDoc As Docurent = Application. Docunment Manager. Mli Acti veDocunent
Di m acCur Db As Dat abase = acDoc. Dat abase

Usi ng acTrans As Transaction = acCurDb. Transacti onManager. Start Transacti on()
"' Open the Block table record for read
Di m acBl kThl As Bl ockTabl e
acBl kThl = acTrans. Get Obj ect (acCur Db. Bl ockTabl el d,
OpenMbde. For Read)



"' Open the Block table record Mddel space for read

Di m acBl kThl Rec As Bl ockTabl eRecord

acBl kThl Rec = acTrans. Get Obj ect (acBl kTbl ( Bl ockTabl eRecor d. Model Space),
OpenMbde. For Read)

DmnCnt As Integer = 0
acDoc. Edi tor. WiteMessage(vbLf & "Model space objects: ")
"' Step through each object in Mdel space and
di splay the type of object found
For Each acOhjld As Objectld In acBl kThl Rec
acDoc. Edi tor. WiteMessage(vbLf & acObjld. Objectd ass() . Dxf Nane)

nCnt = nCnt + 1
Next
"'* If no objects are found then display the follow ng nessage
If nCnt = 0 Then

acDoc. Edi tor. WiteMessage(vbLf & " No objects found")
End If
"' Dispose of the transaction

End Usi ng

End Sub

C#

usi ng Aut odesk. Aut oCAD. Runt i e;
usi ng Aut odesk. Aut oCAD. Appl i cati onServi ces;
usi ng Aut odesk. Aut oCAD. Dat abaseSer vi ces;

[ CommandMet hod( " Li stEntities")]

public static void ListEntities()

{
// Get the current docunent and dat abase, and start a transaction
Docurent acDoc = Application. Docunment Manager . Mli Acti veDocunent ;
Dat abase acCur Db = acDoc. Dat abase;

using (Transaction acTrans = acCurDb. Transacti onManager. Start Transaction())
{
/1 Open the Block table record for read
Bl ockTabl e acBl kTbl
acBl kThl = acTrans. Get Obj ect (acCur Db. Bl ockTabl el d,
OpenMbde. For Read) as Bl ockTabl e;

/1 Open the Block table record Mddel space for read

Bl ockTabl eRecord acBl kThbl Rec;

acBl kThl Rec = acTrans. Get Qbj ect (acBl kTbl [ Bl ockTabl eRecor d. Model Space] ,
OpenMbde. For Read) as Bl ockTabl eRecor d;

int nCnt = 0;
acDoc. Edi tor. WiteMessage("\nMWodel space objects: ");

/1 Step through each object in Mdel space and
/1 display the type of object found
foreach (Objectld achjld in acBl kThl Rec)

{
acDoc. Edi tor. WiteMessage("\n" + acObjld. Obj ect A ass. Dxf Nane) ;

nCnt = nCnt + 1;
}

/1 1f no objects are found then display a nessage
if (nCnt == 0)
{



acDoc. Editor. WiteMessage("\n No objects found");
}

/1 Dispose of the transaction

}
}

= VBA/ActiveX Code Reference

Sub ListEntities()
This exanple returns the first entity in nodel space
On Error Resume Next
Dmentity As AcadEntity
I f Thi sDrawi ng. Model Space. count <> 0 Then
Set entity = ThisDraw ng. Mbdel Space. I ten(0)
MsgBox entity. hjectNane + _
is the first entity in nodel space."
El se
MsgBox "There are no objects in nodel space.”
End If
End Sub

Access the Application Object

The Application object is at the root of the object hierarchy and it provides access to the main
window of AutoCAD. For example, the following line of code updates the application:

VB.NET
Aut odesk. Aut oCAD. Appl i cati onServi ces. Appl i cati on. Updat eScreen()

C#
Aut odesk. Aut oCAD. Appl i cati onServi ces. Appl i cati on. Updat eScreen();

= VBA/ActiveX Code Reference

Thi sDrawi ng. Appl i cati on. Updat e

Collection Objects

A collection is a type of object that contains many instances of similar objects. The following list
contains some of the collection objects that are found in the AutoCAD .NET API:

Block Table Record
Contains all entities within a specific block definition.
Block Table

Contains all blocks in the drawing.



Named Objects Dictionary

Contains all dictionaries in the drawing.
Dimension Style Table

Contains all dimension styles in the drawing.
Document Collection

Contains all open drawings in the current session.
File Dependency Collection

Contains all items in the File Dependency List.
Group Dictionary

Contains all groups in the drawing.
Hyperlink Collection

Contains all hyperlinks for a given entity.
Layer Table

Contains all layers in the drawing.
Layout Dictionary

Contains all layouts in the drawing.
Linetype Table

Contains all linetypes in the drawing.
MenuBar Collection

Contains all menus currently displayed in AutoCAD.
MenuGroup Collection

Contains all customization groups currently loaded in AutoCAD. A customization group
represents a loaded CUIx file which can contain menus, toolbars, and ribbon tabs among
other elements that define the user interface.

Plot Configuration Dictionary

Contains named plot settings in the drawing.
Registered Application Table

Contains all registered applications in the drawing.

Text Style Table



Contains all text styles in the drawing.
UCS Table

Contains all user coordinate systems (UCS's) in the drawing.
View Table

Contains all views in the drawing.
Viewport Table

Contains all viewports in the drawing.

Topics in this section

Access a Collection

Add a New Member to a Collection Object
Iterate through a Collection Object

Erase a Member of a Collection Object

Access a Collection

Most collection and container objects are accessed through the Document or Database
objects. The Document and Database objects contain a property to access an object or
object id for most of the available Collection objects. For example, the following code defines
a variable and retrieves the LayersTable object which represents the collection of Layers in
the current drawing:

VB.NET

"' CGet the current docunent and start the Transacti on Manager
Di m acCur Db As Dat abase = Applicati on. Docunent Manager. Mli Acti veDocunent . Dat abase
Using acTrans As Transaction = acCurDb. Transacti onManager. Start Transacti on()

"' This exanple returns the layer table for the current database
Dim acLyr Tbl As Layer Tabl e
acLyrTbl = acTrans. Get Obj ect (acCur Db. Layer Tabl el d,

OpenMbde. For Read)

"' Dispose of the transaction
End Usi ng

C#

/1 Get the current docunment and start the Transaction Manager
Dat abase acCurDb = Application. Document Manager . Mli Act i veDocunent . Dat abase;
using (Transaction acTrans = acCurDb. Transacti onManager. Start Transaction())

/1 This exanple returns the |layer table for the current database



Layer Tabl e acLyr Thl ;
acLyrTbl = acTrans. Get Obj ect (acCur Db. Layer Tabl el d,
OpenMbde. For Read) as Layer Tabl €;

/1 Dispose of the transaction

}
= VBA/ActiveX Code Reference

Dim | ayer Col | ecti on as AcadlLayers
Set | ayerCol | ection = Thi sDraw ng. Layers

Add a New Member to a Collection Object

To add a new member to the collection, use the Add method. For example, the following
code creates a new layer and adds it to the Layer table:

VB.NET

| mports Aut odesk. Aut oCAD. Runti ne
| mports Aut odesk. Aut oCAD. Appl i cati onServi ces
| nports Aut odesk. Aut oCAD. Dat abaseSer vi ces

<CommandMet hod( " AddMyLayer")> _

Public Sub AddMyLayer ()
"' CGet the current docunent and database, and start a transaction
Di m acDoc As Document = Application. Docunent Manager. Mli Acti veDocunent
Di m acCur Db As Dat abase = acDoc. Dat abase

Usi ng acTrans As Transacti on = acCurDb. Transacti onManager. Start Transacti on()
"' Returns the layer table for the current database
Di m acLyr Tbl As Layer Tabl e
acLyrThl = acTrans. Get Obj ect (acCur Db. Layer Tabl el d,
OpenMbde. For Read)
"' Check to see if MyLayer exists in the Layer table
I f Not acLyrTbl.Has("MLayer") Then
"' Open the Layer Table for wite
acLyr Tbl . Upgr adeQpen()
"' Create a new |l ayer table record and nanme the |ayer "MlLayer"
Di m acLyr Thl Rec As Layer Tabl eRecord = New Layer Tabl eRecord
acLyr Tbl Rec. Nane = "MLayer"
"' Add the new | ayer table record to the layer table and the transaction
acLyr Tbl . Add(acLyr Thl Rec)
acTrans. AddNew yCr eat edDBObj ect (acLyr Thl Rec, True)
"' Conmit the changes
acTrans. Conmit ()
End If
"' Dispose of the transaction
End Usi ng
End Sub

C#
usi ng Aut odesk. Aut oCAD. Runti ne;



usi ng Aut odesk. Aut oCAD. Appl i cati onServi ces;
usi ng Aut odesk. Aut oCAD. Dat abaseSer vi ces;

[ CommandMet hod( " AddMyLayer ") ]

public static void AddMyLayer ()

{
// Get the current docunent and dat abase, and start a transaction
Docurent acDoc = Application. Docunent Manager . Mli Acti veDocunent ;
Dat abase acCur Db = acDoc. Dat abase;

using (Transaction acTrans = acCurDb. Transacti onManager. Start Transaction())
{
/1 Returns the layer table for the current database
Layer Tabl e acLyr Tbl ;
acLyrThl = acTrans. Get Obj ect (acCur Db. Layer Tabl el d,
OpenMbde. For Read) as Layer Tabl e;

/1 Check to see if MyLayer exists in the Layer table
i f (acLyrTbl.Has("M/Layer") != true)

{
/1 Open the Layer Table for wite
acLyr Tbl . Upgr adeQpen() ;
/1l Create a new | ayer table record and nane the | ayer "MLayer"
Layer Tabl eRecord acLyr Thl Rec = new Layer Tabl eRecord();
acLyr Tbl Rec. Nane = "MLayer";
/1 Add the new | ayer table record to the layer table and the transaction
acLyr Tbl . Add(acLyr Thl Rec) ;
acTrans. AddNew yCr eat edDBObj ect (acLyr Thl Rec, true);
/1 Commt the changes
acTrans. Commit();
}

/1 Dispose of the transaction

= VBA/ActiveX Code Reference

Sub AddMyLayer ()

Di m newLayer as AcadLayer

Set newLayer = Thi sDrawi ng. Layers. Add(" MyLayer")
End Sub

Iterate through a Collection Object

To select a specific member of a Collection object, use the Item or GetAt method. The Item
and GetAt methods require a key in the form of a string in which represents the name of the
item. With most collections, the Item method is implied, meaning you do not actually need to
use method.

With some Collection objects, you can also use an index number to specify the location of
the item within the collection you want to retrieve. The method you can use varies based on
the language you are using as well as if you are working with a symbol table or dictionary.



The following statements show how to access the “MyLayer” table record in Layer symbol
table.

VB.NET

acbjld = acLyrThbl . Itenm(" MyLayer")
acObj ld = acLyrThbl (" MyLayer")

C#

acObjld = acLyrThbl ["MyLayer"];

= VBA/ActiveX Code Reference

acLayer = ThisDrawi ng. Layers. |tem("M/VLayer")

aclLayer Thi sDrawi ng. Layer s(" MyLayer")

Iterate through the LayerTable object

The following example iterates through the LayerTable object and displays the names of all
its layer table records:

VB.NET

| mports Aut odesk. Aut oCAD. Runti ne
| mports Autodesk. Aut oCAD. Appl i cati onServi ces
| mports Aut odesk. Aut oCAD. Dat abaseSer vi ces

<CommandMet hod(" It er at eLayers")> _

Public Sub IteratelLayers()
"' Get the current document and dat abase, and start a transaction
Di m acDoc As Documnent = Application. Docunment Manager. Mli Acti veDocunent
Di m acCur Db As Dat abase = acDoc. Dat abase

Usi ng acTrans As Transacti on = acCurDb. Transacti onManager. Start Transacti on()
"' This exanple returns the layer table for the current database
Di m acLyr Tbl As Layer Tabl e
acLyrThl = acTrans. Get Obj ect (acCur Db. Layer Tabl el d,
OpenMbde. For Read)
"' Step through the Layer table and print each |ayer name
For Each acOojld As Objectld In acLyrThl
Di m acLyr Tbl Rec As Layer Tabl eRecord
acLyr Tbhl Rec = acTrans. Get Obj ect (acbj | d, OpenhMbde. For Read)

acDoc. Editor. WiteMessage(vbLf & acLyr Tbl Rec. Nane)
Next
"' Dispose of the transaction
End Usi ng
End Sub

C#

usi ng Aut odesk. Aut oCAD. Runt i e;
usi ng Aut odesk. Aut oCAD. Appl i cati onServi ces;
usi ng Aut odesk. Aut oCAD. Dat abaseSer vi ces;

[ CommandMet hod( "It erat eLayers™)]
public static void IteratelLayers()



// Get the current docunent and dat abase, and start a transaction
Docurent acDoc = Application. Docunent Manager . Mli Acti veDocunent ;
Dat abase acCur Db = acDoc. Dat abase;

using (Transaction acTrans = acCurDb. Transacti onManager. Start Transaction())

/1 This exanple returns the layer table for the current database
Layer Tabl e acLyr Tbl ;
acLyrThl = acTrans. Get Obj ect (acCur Db. Layer Tabl el d,

OpenMbde. For Read) as Layer Tabl e;

/1 Step through the Layer table and print each |ayer nane
foreach (Objectld acOojld in acLyrThl)

{
Layer Tabl eRecord acLyr Tbl Rec;
acLyr Thl Rec = acTrans. Get Obj ect (acObj | d,
OpenMbde. For Read) as Layer Tabl eRecor d;
acDoc. Edi tor. WiteMessage("\n" + acLyr Tbl Rec. Name) ;
}

/1 Dispose of the transaction

= VBA/ActiveX Code Reference

Sub IteratelLayers()
" lterate through the collection
On Error Resunme Next

Dimlay As AcadLayer

Dimmsg As String

neg = ""

For Each lay In ThisDraw ng. Layers
nsg = nsg + |lay. Nane + vbCrLf

Next

Thi sDrawi ng. Utility. pronpt nsg
End Sub

Find the layer table record named MyLayer in the LayerTable object

The following example checks the LayerTable object to determine if the layer named
MyLayer exists or not, and displays the appropriate message:

VB.NET

| mports Autodesk. Aut oCAD. Runti me
| mports Aut odesk. Aut oCAD. Appl i cati onServi ces
| nports Aut odesk. Aut oCAD. Dat abaseSer vi ces

<ConmandMet hod( " Fi ndMyLayer") > _

Publ i ¢ Sub Fi ndMyLayer ()
"' CGet the current docunent and database, and start a transaction
Di m acDoc As Document = Application. Docunment Manager. Mli Acti veDocunent
Di m acCur Db As Dat abase = acDoc. Dat abase

Usi ng acTrans As Transaction = acCurDb. Transacti onManager. Start Transacti on()



Returns the layer table for the current database

Di m acLyr Thl As Layer Tabl e

acLyrTbl = acTrans. Get Obj ect (acCur Db. Layer Tabl el d,
OpenMbde. For Read)

"' Check to see if MyLayer exists in the Layer table

If Not acLyrTbl.Has("MLayer") Then

acDoc. Edi tor. WiteMessage(vbLf & "' MyLayer' does not exist")

El se
acDoc. Edi tor. WiteMessage(vbLf & "' MyLayer' exists")
End If
"' Dispose of the transaction
End Usi ng
End Sub
C#

usi ng Aut odesk. Aut oCAD. Runt i e;
usi ng Aut odesk. Aut oCAD. Appl i cati onServi ces;
usi ng Aut odesk. Aut oCAD. Dat abaseSer vi ces;

[ CommandMet hod( " Fi ndMyLayer")]

public static void Fi ndWLayer ()

{
/Il Get the current docunent and dat abase, and start a transaction
Docurent acDoc = Application. Docunment Manager . Mli Acti veDocunent ;
Dat abase acCur Db = acDoc. Dat abase;

using (Transaction acTrans = acCurDb. Transacti onManager. Start Transaction())

/1 Returns the layer table for the current database
Layer Tabl e acLyr Tbl ;
acLyrThl = acTrans. Get Obj ect (acCur Db. Layer Tabl el d,
OpenMbde. For Read) as Layer Tabl e;

/1 Check to see if MyLayer exists in the Layer table
i f (acLyrTbl.Has("M/Layer") != true)

{
acDoc. Edi tor. WiteMessage("\n' MyLayer' does not exist");
}
el se
{
acDoc. Edi tor. WiteMessage("\n' MyLayer' exists");
}

/1 Dispose of the transaction

= VBA/ActiveX Code Reference

Sub Fi ndMyLayer ()
' Use the Itemnethod to find a | ayer named MyLayer
On Error Resume Next
Di m ABCLayer As AcadLayer
Set ABCLayer = Thi sDrawi ng. Layers("MLayer")
If Err <> 0 Then
Thi sDrawi ng. Utility. pronpt "' MyLayer' does not exist"
El se
Thi sDrawi ng. Utility. pronpt "' MyLayer' exists"
End If



End Sub

Erase a Member of a Collection Object

Members from a collection object can be erased using the Erase method found on the
member object. For example, the following code erases the layer MyLayer from the
LayerTable object.

Before you erase a layer from a drawing, you should make sure it can be safely removed. To
determine if a layer or another named object such as a block or text style can be erased, you
should use the Purge method. For information on the Purge method, see Purge
Unreferenced Named Objects.

VB.NET

| mports Aut odesk. Aut oCAD. Runti ne
| mports Aut odesk. Aut oCAD. Appl i cati onServi ces
| mports Aut odesk. Aut oCAD. Dat abaseSer vi ces

<CommandMet hod( " RemoveMyLayer") > _

Publ i c Sub RemoveMyLayer ()
"' CGet the current docunment and dat abase, and start a transaction
Di m acDoc As Document = Applicati on. Docunment Manager . Mli Acti veDocunent
Di m acCur Db As Dat abase = acDoc. Dat abase

Using acTrans As Transacti on = acCurDb. Transacti onManager. Start Transacti on()
"' Returns the layer table for the current database
Di m acLyr Tbl As Layer Tabl e
acLyrThl = acTrans. Get Obj ect (acCur Db. Layer Tabl el d,
OpenMbde. For Read)
"' Check to see if MyLayer exists in the Layer table
I f acLyrTbl . Has("M/Layer") = True Then
Di m acLyr Tbl Rec As Layer Tabl eRecord
acLyr Thl Rec = acTrans. Get Qbj ect (acLyr Thl (" MyLayer"),
OpenMbde. ForWite)

Try
acLyr Thl Rec. Er ase()
acDoc. Edi tor. WiteMessage(vbLf & "' MyLayer' was erased")
"' Conmmit the changes
acTrans. Commit ()
Cat ch
acDoc. Editor. WiteMessage(vbLf & "' MyLayer' coul d not be erased")
End Try
El se
acDoc. Edi tor. WiteMessage(vbLf & "' MyLayer' does not exist")
End If
"' Dispose of the transaction
End Usi ng
End Sub

C#



usi ng Aut odesk. Aut oCAD. Runti ne;
usi ng Aut odesk. Aut oCAD. Appl i cati onServi ces;
usi ng Aut odesk. Aut oCAD. Dat abaseSer vi ces;

[ CommandMet hod( " RenoveMyLayer ™) ]

public static void RenoveMyLayer ()

{
/1 Get the current docunment and dat abase, and start a transaction
Docurent acDoc = Application. Docunent Manager . Mli Acti veDocunent ;
Dat abase acCurDb = acDoc. Dat abase;

using (Transaction acTrans = acCurDb. Transacti onManager. Start Transacti on())
{
/1 Returns the layer table for the current database
Layer Tabl e acLyr Thl ;
acLyrThl = acTrans. Get Obj ect (acCur Db. Layer Tabl el d,
OpenMbde. For Read) as Layer Tabl e;

/1 Check to see if MyLayer exists in the Layer table
i f (acLyrTbl.Has("MVLayer") == true)

{
Layer Tabl eRecord acLyr Thl Rec;
acLyr Tbl Rec = acTrans. Get Qbj ect (acLyr Thl [ " MyLayer"],
OpenMbde. ForWite) as Layer Tabl eRecord;
try
{
acLyr Tbl Rec. Erase();
acDoc. Edi tor. WiteMessage("\n' MyLayer' was erased");
/1 Conmmit the changes
acTrans. Commit();
}
catch
{ | |
acDoc. Edi tor. WiteMessage("\n' 